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Introduction
You’re probably used to accumulating and then calculating the times
for your payroll in the same time-consuming and error-prone way
you’ve been doing it for years, but you’ve finally decided it’s taking up
too much of your time, and you could do without the stress.
We created our Time and Attendance programs for people like you, to
reduce the stress of employee payroll data collection - to make it easier
and quicker so you’ve got more time to do all those other things you’d
rather be doing.
TimeSheet FirstStep is our entry level product, intended for smaller
companies, branch offices, and trial installations at larger companies.
FirstStep provides these advantages:

• Allows up to 16 employees.
• No need to set or define shifts.
• Easily handles multiple work periods per day.
• Allows work periods to extend over midnight.
• Normal time and three overtime pay categories.
• Automatic rounding of clock in and clock out times.
• Scheduled or manual collection of clocking data.
• Reports of adjusted and unadjusted time with totals.

You can upgrade from FirstStep to any of our other Time and
Attendance solutions, including ZipNet TimeSheet, TimeSheet
Express, and our ZipNet Terminal, at any time with full credit for
your FirstStep purchase!  FirstStep files are completely upward
compatible with TimeSheet Express.
TimeSheet FirstStep and ASP ClickClock are designed for Windows 95
or later operating systems.
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Installing FirstStep and ClickClock
TimeSheet FirstStep and ASP ClickClock are normally supplied on a
CD-ROM.  The installation program should start automatically when
you insert the CD into your CD-ROM drive.  If it doesn’t, select RUN
from the Windows Start menu,
then type x:\setup (where x: is
your CD-ROM drive letter).  Then
simply follow the on-screen
instructions, shown on the right.
First, press the 1 button to install
TimeSheet FirstStep, which is
best installed on the computer of
the person who looks after your
payroll.  Next, you’ll need to set up
FirstStep, so go read the section
starting with The Main Screen on page 6, set up FirstStep, and then
come back here.
Next, press the 2 button to install ASP ClickClock, either on the same
computer, or on the computer you want staff to clock in and out from.
Go read the section on ASP ClickClock on page 13.  Note that
ClickClock automatically installs itself into the startup group, so that it
runs whenever the computer it is installed on is running.
The 3 button allows you to view the FirstStep manual, provided you
have the free Adobe Acrobat Reader installed on your computer.  If you
don’t, the setup screen has a link you can click to install it.

Unlocking FirstStep and ClickClock
So you can evaluate TimeSheet FirstStep and ASP ClickClock to
ensure that they meet your needs before purchase, the programs are
supplied in a form that allows them to run for 14 days from the date of
installation before they must be registered.  Except for the 14 day limit,
the evaluation versions are fully functional.
Until they are registered,
the programs will display
a Reminder Screen, as
shown on the right, each
time they are run.
Press the OK button to
evaluate the program, or
the Register button to
enter your registration
details and unlock the
program.  Pressing the Visit Website button takes you to ASP’s web
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site, if your system is connected to the
internet and set up correctly.
When you press the Register button, the
screen on the right is displayed.  Note that a
Hardware Fingerprint code is displayed –
this code is unique to the particular
computer the program is running on, and
the program itself.
To register TimeSheet FirstStep and ASP ClickClock, you need to
install them both (possibly on different computers), then contact ASP,
and using the Hardware Fingerprint codes and the name you want the
programs to be registered under, ASP will generate Activation Keys for
you that will register and unlock the programs.  The Registered Name
and Activation Key are then entered into this screen for each of the
programs.  Once a program is registered, you’ll never see the reminder
screen again.
Note that Activation Keys are specific to the program, the computer the
program is running on, and the name the program is registered under.
You cannot use the activation key on any other computer, or for any
other program.
Please also note that it is not possible to extend the evaluation period
beyond 14 days.  You could, however, install the program on another
computer and continue running the program for a further 14 days on
that computer.

Getting Started
The easiest way to get you up and running with FirstStep is to take you
through the program, step by step.  If you haven’t already, you should
install TimeSheet FirstStep now.
Before you do anything else, you’ll need to get to know the layout of
FirstStep’s main screen.  On the next page, we give a brief overview of
the screen that you will see every time you open FirstStep, and we
follow that with a step by step guide that will get you up and running
with FirstStep and ClickClock in no time at all.
After that, the remainder of the manual is mainly a reference guide that
explains all sections of the programs, followed by a section containing
answers to some commonly asked questions, and we finish the manual
with a glossary and copyright, licence and warranty information.
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The Main Screen
Every time you run FirstStep, it starts up in the Edit Scans screen, with
the first employee in
your database displayed.
On the left side of this
screen, you’ll see a set
of icons that take you to
the most often used
parts of the program.
This section is
comprised of two parts –
General (as shown on
the left below) and

Setup (as
shown on the right below).  To change between the two
sections, click on the General heading or the
Setup heading.
The General section (shown on the left) allows
access to the Edit Scans screen (the screen
that’s always displayed when you run FirstStep),
and the Employees, Download and Reports
screens.
The Setup section (shown on the right) allows
access to all the configuration options available
in FirstStep.
All the sections of FirstStep are described later
in this manual - just click on an icon to open that
part of FirstStep.

The File, Setup, Edit, Reports and Help menus along the
top of the screen can also be used to access the various
sections of FirstStep, while the toolbar icons underneath the
menus provide quick access to (from left to right) the File

Open  and File Save  operations,
the Cut , Copy , Paste , and
Delete  functions, and the FirstStep Help file .

Now, we can move on to getting you up and running with FirstStep.
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Creating a new database
The first time you run FirstStep, you won’t have a database, so you’ll
see this message, explaining that you can’t use FirstStep until you
create a database.

If you press the Yes key, a new database will be created.  A FirstStep
database always needs to contain at least one employee, or it will not
function.  For this reason, when you create a new database, an
employee called An Employee, with an Employee ID of 000, is added.
You can delete this extra employee anytime after you’ve entered at least
one of your own employees, but you can never have less than one
employee, and remember that FirstStep has a limit of 16 employees.  If
you have more than 16 employees, you should upgrade to TimeSheet
Express, or one of ASP’s other Time and Attendance systems.
Once you’ve told FirstStep to create a new database, you’ll receive this
reminder:

After you press the OK button, the Edit Employees screen will be
open, ready for you to enter the details for your employees.  There are
two ways to do this – by entering the details manually using the
keyboard, or by importing the data from a suitable formatted text file.
To manually enter an
employee from the
keyboard, right click
in the grey part of
the Employees
screen, then select
Add New from the
menu that pops up.
The screen on the
right will be
displayed:
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Enter the employee’s First Name and Last Name, then enter a unique
identifying number for the employee into the Employee ID field.  If
you’re using ClickClock to clock in and out, the Employee ID can be
anything you like, except that it must be unique – that is, you cannot
use the same number for more than one employee.  If you’re using
barcoded cards, or iButton tags, the Employee ID will be the barcode
or tag number for this employee.
The Export ID field need only be used if you require a different
identifying number to be exported for employees – this might be useful,
for example, if you are using barcoded cards with different numbers to
that required by your payroll program.  If this field is left blank, the
Employee ID will be used instead.  In most circumstances, this field
should be left blank.
The Start Date is the date that the employee started work for the
company, or the date that they were entered into FirstStep.  This
defaults to the current date when a new employee is added, but can be
changed by clicking on the grey down arrow to the right of the date,
which brings up a pop up calendar  (See the glossary for more
information on the pop up calendar).  Note that clock in and out data for
an employee will not be accepted by the program for dates before the
Start Date set here.
The Termination Date is the date that this employee ceased
employment with the company.  Click on the grey down arrow to the
right of the date to bring up a pop up calendar, as described above.
Setting a date in this field puts a tick in the box in the left of the field,
which indicates that the employee is no longer employed after the date
set.  To re-enable the employee, click in the box in the left of the field
to remove the tick.  You can set the Termination Date field to any date,
provided the employee has not already clocked in or out after the date
set here.  Once this field is set, scans will not be accepted after the date
set here.
The Work Zone field is optional, and is used to indicate the area of the
company that the employee works in, or is to be costed in.  You can
enter any text here, and the default for newly added employees is
Default.  FirstStep allows reports to be restricted to particular Work
Zones, which is the primary use of this field.
The Note field allows you to add a small amount of free format text to
an employee’s entry.  This field does not appear on any FirstStep
reports.
Once you’ve entered all the information for the employee, press the
Save button, then the Close button if you’re finished adding employees.
If you want to add another employee, click on the New button instead,
and enter the information for the next employee.
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For the time being, you can ignore the other tabs (or sections) on the
Adding a new employee screen – see Options on page 31 for more
details on these options.  Note that settings on these tabs are for the
particular employee only, and override the options set on the Options
screen.
If you have (or can create) a text file containing a list of your
employees and their ID numbers, FirstStep can import this list instead
of making you type everything in manually as described above - see
Importing Employee Details from a Text File on page 37 for more
details.

Setting the Main Program Options
Next, you need to set up the main program options.  Select Options
from the Setup menu, which will bring up a screen with six tabs (or
sections).  See page 31 for more detailed information on this and the
other main program options.
Note that these are all “global” settings (that is, they affect all
employees), but you can set options for individual employees from the
Edit Employee screen.

Clock In and Clock Out Time RoundingClock In and Clock Out Time RoundingClock In and Clock Out Time RoundingClock In and Clock Out Time Rounding
The next most important option is Rounding, which is designed to save
you time and effort by automatically rounding your employee clock in
and out times to the
settings you’ve specified.
Rounding is set from the
Rounding tab on the
Options screen – see the
screen fragment on the
right.
There are two rounding
options – one controls the
rounding for all clock in
scans, and the other controls the rounding for all clock out scans.
Rounding can be set to round up to the next preset interval, round down
to the previous preset interval, or round to the nearest preset interval.
Intervals of 5, 6, 10, 15, 30 and 60 minutes are available.
Most employees tend to clock in a little before their official starting
time, and clock out a bit after their official finishing time.  As an
example, if your staff work from 09:00 to 17:30, you may find that
most of them clock in between (say) 08:45 and 09:00, and most of them
clock out between 17:30 and 17:45.
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If you set the Clock In Rounding to round up to the next 15 minutes,
and the Clock Out Rounding to round down to the previous 15
minutes, then everyone who clocked in between 08:46 and 09:00 would
have their clock in time automatically rounded up to 09:00, and
everyone who clocked out between 17:30 and 17:45 would have their
clock out time automatically rounded back to 17:30.  If you have more
than a very few employees, this would save you considerable time by
not needed to manually edit their times to the right values.
Rounding can also help in other ways – if you pay your employees in
particular increments (for example, 15 minute increments, or tenth of an
hour (ie 6 minutes) increments), you could set FirstStep to round to
those values.

Meal BreaksMeal BreaksMeal BreaksMeal Breaks
Next, you need to configure FirstStep to handle meal breaks.  There are
three possibilities - if you want your employees to clock in and out for
their meal breaks, or if you pay your employees for their meal breaks,
you don’t have to do anything special.  The third possibility is that your
employees aren’t paid for their meal breaks, and you don’t want them to
clock in and out for them.
To configure FirstStep to do
this, you need to go to the
Meal Break tab and check
the box that says
Automatically deduct
meal break.  Then, set the length of the meal break (in hours and
minutes) in the box after the word Deduct, and set the number of hours
that have to be worked before a meal break is given.
The way that automatic meal breaks work with FirstStep is that after the
specified number of hours are worked, the length of the meal break is
subtracted from the total of hours worked for that day.  A good “rule of
thumb” is that the number of hours that must be worked should be set to
the number of hours between the start of work and the meal break, plus
the length of the meal break.
For example, if your staff work from 9:00 to 17:30, and have a one hour
meal break at 12:30, you could set the number of hours that must be
worked to 5 (that is, five hours).  That way, unless your staff come back
from their meal break, the meal break won’t be subtracted from their
hours.  This would also work if staff sometimes worked half days,
because unless they worked more than the number of hours set here, no
meal break would be automatically deducted.  Note that only whole
numbers of hours can be entered here.
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OvertimeOvertimeOvertimeOvertime
FirstStep has three overtime
categories, which are set to begin
after a specified number of hours
have been worked.  For example,
Overtime1 might be set to start
after 8 hours have been worked,
Overtime2 after 10 hours, and Overtime3 after 12 hours, as shown in
the screen fragment above.  Note that the numbers entered here are not
times (ie 08:00 is not 8am), they are the number of hours that must be
worked before the overtime starts accumulating.
If the Same settings for every day option is selected, the one set of
overtime thresholds are used for every day of the week.  If this option is
not selected, you can set different overtime thresholds for different days
of the week.

MidnightMidnightMidnightMidnight
FirstStep always works with single days – a work period is not allowed
to continue over midnight.  If an employee does work over midnight,
FirstStep handles the situation by “pretending” that the employee
finished work at the end of one day (ie at 24:00), then started work
again immediately at the start of the next day (ie at 00:00).
By setting this option, FirstStep can automatically add a 24:00 scan to
the end of a day and a 00:00 scan to the start of the next day, when an
employee’s final scan for the day is within the specified number of
hours before midnight.

Display PeriodDisplay PeriodDisplay PeriodDisplay Period
Click on the Display Period tab to open this section.  The Display
Period should be set to correspond to your pay period – most likely, it
will be 7 or 14 days, but you can set it to any period you require.

Auto HighlightAuto HighlightAuto HighlightAuto Highlight
One of FirstStep’s handiest options is provided on the Auto Highlight
tab.  FirstStep can be set to automatically highlight days on the Edit
Scans screen where the
total number of hours
worked for the day are
less than or more than a
specified amount.  This
makes it easier to see
which times may need to be adjusted.  If you want to use this facility,
check the box marked Auto Highlight, then enter times in hours and
minutes into the less than and more than boxes.
Once you’ve finished setting the options, press the Save button, then
the Close button.
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Data Collection
Finally, you need to let FirstStep know where the clock in and clock out
scan data is coming from, and how often to collect it.
To do this, select
Data Collection from
the Setup menu, to
bring up the screen
shown on the right.
You’ll probably be
using the
ASP ClickClock
program to collect
your employee clock-
ins and clock-outs, so
set the Scanner Type
to ASP ClickClock, and set the Text File to store the collected data on
the computer that FirstStep is installed on, and in the folder it is
installed in, as shown above.
If you’re using ASP ClickClock, select the
Poll Options tab, make sure the Scheduled Poll
checkbox is not ticked, and set the Frequency to 15
minutes, as shown in the screen fragment on the
right.  Otherwise, see the Data Collection and
Downloading section of this manual on page 36 for
more options.
Click on the Save button, then the Close button, and you’re now almost
ready to start using FirstStep.
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ASP ClickClock
ASP ClickClock allows you to use any old Windows 95 or later
computer as a staff time clock for TimeSheet FirstStep.
Employees simply find their name and double click on it to clock in or
out – it’s that simple.
Before you can use ClickClock, you have to set it up, and the Setup
Wizard leads you through that process.  ClickClock needs to know who
your employees are, so their names can be displayed, so if you haven’t
installed and set up TimeSheet FirstStep yet, go do it now, then come
back here and start again.
Once your
employees are
entered into
FirstStep,
ClickClock needs
to be able to access
the list of
employees.  There
are several ways
FirstStep and
ClickClock can be
installed:

• FirstStep and ClickClock are installed and used on the same
computer.  This may sometimes be a little inconvenient, because
your employees may need to clock in or out while the computer is
in use.

• FirstStep and ClickClock are installed on different computers, and
the computers are both connected to a network and are able to
communicate via a shared drive.  This is probably the ideal setup.

• FirstStep and ClickClock are installed on different computers, but
the computers are not connected in any way.  In this case, data is
transferred manually via a floppy disk.

The Setup Wizard next asks you whether the computer you’ve installed
ClickClock on is able to directly access the drive and folder that
FirstStep is installed on.  You’d answer Yes here in either of the first
two cases above, or No if you were intending to transfer data via a
floppy disk.
If you answer Yes, you are then asked to set the filename and location
of the Employee.ini file created by FirstStep, which is stored in the
folder that FirstStep is installed in (c:\Program Files\Asp\FirstStep).
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Once you’ve set the location of this file, you are asked whether you
want to store the clock in/clock out data collected by ClickClock into
the same location.  Usually, the answer here would be yes.
If you answer No, you’re telling ClickClock that this computer is a
“stand alone” system, not connected to the computer running FirstStep
at all, and that you want to use a floppy disk to transfer the employee
list to ClickClock when needed, and to carry the clock in/clock out data
from ClickClock to FirstStep.  ClickClock will now ask you to go to the
computer where FirstStep is installed, run FirstStep, insert a blank
floppy disk, then go to the File menu and select Copy Employee File
To Floppy Disk.  When that’s done, bring the disk back to the
ClickClock computer, put in into the floppy drive, then press the OK
button.
Whether you answered Yes or No, the setup wizard now asks you to let
it know where the Employee.ini file is, which will either be on the
floppy disk you just created, or on the folder and drive that FirstStep
was installed into.
You’ll probably want to transfer the data from ClickClock to FirstStep
in the same way that you transferred the Employee.ini file – either
ClickClock will have direct access to the folder and drive that FirstStep
was installed into, or you’ll be transferring the data as needed via a
floppy disk.  The setup wizard asks you to confirm this – if you answer
No, you will have to manually set up ClickClock by selecting Setup
from the File menu.
ClickClock is now ready to use!

Manually Configuring ASP ClickClock
The first time you run ASP ClickClock, the Setup Wizard guides you
through configuration, as described above.  If you ever need to change
the settings, select Setup from the File menu.  Each of the setup options
is described below.

Display Employee IDsDisplay Employee IDsDisplay Employee IDsDisplay Employee IDs
If the Display Employee IDs checkbox is
ticked, the employee ID numbers from
FirstStep will be displayed before each
employee name, as shown on the right.  If
the checkbox is not ticked, only the names
will be displayed.
Names are always sorted by employee ID number, or by surname if
employee ID numbers are not being displayed.  Note that it you have
long employee ID numbers, you may lose some of the name, as you can
see with the fourth name in the screen fragment above.
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Text Output File LocationText Output File LocationText Output File LocationText Output File Location
This item sets the file where the collected clocking information will be
stored.  If the computer you're running ClickClock on is connected to a
network with the computer that FirstStep is on, you should store the
data onto the drive and folder that FirstStep is installed on.
Otherwise, you should set it to the folder that ClickClock is installed in
(c:\Program Files\Asp\FirstStep) and use the Copy Output File To
Floppy Disk function in the File menu to copy the collected data to
floppy disk or another location as required.

Employees File LocationEmployees File LocationEmployees File LocationEmployees File Location
ClickClock needs a list of employees to be able to work. FirstStep
creates or updates a file called Employee.ini each time that an
employee is added or deleted, or any employee details are changed.
This file is stored in the folder that FirstStep is installed into, so if the
ClickClock computer has access to this folder via a network, you
should set this item to that location.
Otherwise, you should set it to the folder that ClickClock is installed in
(by default, this will be c:\Program Files\Asp\FirstStep) and use the
Import Employees File function in the File menu to copy the file from
floppy disk or another location as required.

PasswordPasswordPasswordPassword
ClickClock allows you to set a password that is required before you can
move the collected data onto a floppy disk.  Once you set a password,
every time you use the Copy Output File To Floppy Disk function,
you will need to enter the password.
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Using ASP ClickClock
ASP ClickClock includes itself in the Startup folder of the computer it
is installed on, so that it runs whenever the computer is used.
When ClickClock is running,
employees simply find their
name and double click on it to
clock in or out.
The ClickClock main screen
(shown on the right) contains
two lists - one of employees
who have not clocked in using
ClickClock, and the other a
list of those who have.  The
current time (of the computer
that ClickClock is installed
on) is also displayed.
To clock in using ClickClock,
find your name in the Out section of the screen, and double click on it.
This will move your name to the In section.  To clock out, you do much
the same thing - find your name in the In section of the screen, and
double click on it.
ClickClock provides tool tips (ie helpful little text messages that appear
when you hold the mouse cursor over something) to help you
understand how to use it, but once it’s been explained, it’s really quite
simple.
You can operate ClickClock using the keyboard, as well as the mouse.
The tab key moves the highlight between the Out and In lists, while the
up arrow and down arrow keys move the highlight between
employees.  Once you get to the employee you want, simply press the
enter key to move the employee from one side to the other.
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Transferring data between FirstStep and ClickClock
There are two ways data can be transferred between FirstStep and
ClickClock:

• FirstStep and ClickClock are installed and used on the same
computer, or are installed on different computers, but the computers
are both connected via a network.
If this case, virtually everything happens automatically.  Clock in
and clock out data is stored on the computer that FirstStep is
installed on, and FirstStep will collect that data periodically as it is
configured.  When you add, edit or delete employees, ClickClock
will reflect those changes either the next time it is started, or when
Import Employees File is run from its File menu.

• FirstStep and ClickClock are installed on different computers, and
the computers are not connected in any way, so the data is
transferred manually via a floppy disk.
In this case, clock in and clock out data is transferred to FirstStep by
putting a floppy disk into the ClickClock computer, and selecting
Copy Output File To Floppy Disk on the File menu.  The floppy is
then taken to the computer running FirstStep, going to the Data
Collection screen, and pressing the Manual Poll button.  After you
add, edit or delete employees, put a floppy disk into the FirstStep
computer, and select Copy Employee File To Floppy Disk on the
File menu, then take the disk to the ClickClock computer and select
Import Employees File from the File menu.

What if something goes wrong with the floppy disk?What if something goes wrong with the floppy disk?What if something goes wrong with the floppy disk?What if something goes wrong with the floppy disk?
What if you lose the floppy disk on the way to the FirstStep computer,
or the dog eats it, or when you get there, there’s an error on the floppy
disk?  ClickClock keeps a backup of the last file written to the floppy
disk, and you can copy that file at any time from the Help menu, by
selecting Copy Backup File To Floppy Disk.
ClickClock keeps this backup file until the next time you copy collected
data to the floppy disk, at which time, the newly transferred data
replaces the old backup file to become the new backup file.
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Using TimeSheet FirstStep
The general idea is that FirstStep will process the clock in and clock out
information entered using the ASP ClickClock program, and
automatically adjust the times as specified by the rounding and meal
break options you’ve set.
It’s then your job to check the data, either on the screen or via a printed
Unadjusted Report, make whatever manual adjustments are required,
and then print out or export the final figures for use by the person who
issues the pay cheques.

Adjusting Times
After data has been collected, the clock in and out times will need to be
checked, and corrected if necessary.  This is done from the Edit Scans
screen.
FirstStep saves the Start Date every time you exit, so that when you
run it again, the same start date is used.
When you open the Edit Scans screen, the Start Date there will be the
same as it was the last time you used FirstStep, and the clock in and out
times on the screen will be shown for the first employee in your
database, for the number of days that you have set for the Display
Period.
The In and Out times on the screen will have been adjusted according to
the Rounding rules you have set, and the totals for each day will be the
difference between the in and out times less the meal break if the times
fit within the meal break rule you’ve set.
Note that FirstStep only displays pairs of in and out times on the main
part of the screen – if there is an odd number of scans for a day, not all
of the scans will be displayed in the main area of the screen.
If you’ve set FirstStep to Auto Highlight if more or less than a certain
number of hours have been worked, days where that rule has been met
will be highlighted in light blue.  Days with an odd number of scans
will also be highlighted, as will any 00:00 and 24:00 scans that have
been automatically added according to the Midnight rule.
Along the bottom of the Edit Scans screen, you’ll find the Total Hours
Displayed, which is a grand total of all the Hours columns that are
displayed on the screen.  If the number of days displayed is the same as
your pay period, and the Starting Date is the first day of your pay
period, this figure will be the adjusted number of hours worked during
the displayed pay period.
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Just above this area of the screen, the unadjusted times for the currently
selected day are displayed, so that you always have access to the raw
figures to base your adjustments on.
To adjust a clock in or out time, click in the cell that you want to
change, to the left of the time.  That will highlight the time that’s
already in the cell, and you can then just type in a new time.  Note that
the unadjusted times for the day that you’re editing are always
displayed at the bottom of the screen.
If you need to insert a time into a blank cell, just click in that cell and
enter the new time.
If you right click on a clock in or clock out time, the
menu shown on the right will pop up, giving you
access to other useful functions, which are described
below.  These functions are all also available using the
buttons along the top of the Edit Scans screen.
To copy the time in the selected cell to the clipboard, select Copy from
the pop up menu, or press the Copy button.  To then paste that time into
another cell, select the cell, right click, and select Paste from the pop up
menu (or, again, press the Paste button).
You can also copy an entire row, rather than a single cell.  This can be
very useful where your employees usually work a fixed number of
hours per day – you can just correct the times for one day (or use a day
that’s already correct), and copy that entire day to other days to correct
them.
To copy an entire row into the clipboard, select a row
rather than a cell by clicking on the grey area at the far
left of the date on a row to move the selection arrow to
that day, as shown on the right.  This will highlight the
row for the selected day.  Then right click and select
Copy from the pop up menu.  To paste all the times for that day to other
days, select another day as described above, then right click to pop up
the menu, and select Paste.
If you need to insert a time either between two existing times, or as the
first time for a day, you need to “slide” some or all of the existing times
to the right to open up a blank cell.  To do this, click in the first cell that
you want to slide to the right, and select Insert from the pop up menu.
If you need to delete a time, right click on the cell containing the time
and select Delete from the pop up menu - all the times to the right of
the deleted cell will move to the left.
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If you need to add a time after the last time for a day, and there are no
blank cells after the last time, right click in the last cell and select
Append from the pop up menu to add a column.
To add a 24:00 time to the end of a day and a 00:00 time to the start of
the next day, select a day as described above, right click, and select
Add Midnight Scans from the pop up menu, or by pressing the button.
Finally, you can print out all the times displayed on the screen by
selecting Print from the right click menu, or by pressing the Print
button.
Note that times must always be entered in order across a row – you
can’t enter an earlier time after a later time.

TimeSheet FirstStep Reports
The various types of reports that FirstStep can generate are described
below.

Adjusted Report with all scans
Shown below is part of an Adjusted Report with all scans, showing a
single employee.

At the top of this segment of the report, the employee’s name,
Employee ID number and Workzone are shown, followed by headings
for each of the columns below.  The left-most column shows the date,
then there’s a pair of clock in and clock out times, followed by the
number of hours between the clock in and clock out times (In/Out
DIFF).  If there is more than one pair of clock in/out times for a day, the
remaining pairs will be listed below the first pair.
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The next four columns list the number of hours that have been assigned
to each of the four pay categories, Normal, OT1, OT2 and OT3,
followed by the total number of hours worked for the day.
You’ve probably noticed that the hours listed under the pay categories
and the In/Out DIFF column do not add up – this is because a meal
break has been subtracted from the In/Out DIFF column.
At the bottom of the report segment, the totals for each of the pay
categories are shown.
If this was an Unadjusted Report, and there were missing scans (for
example, a clock in without a matching clock out), the totals across the
line could not be calculated, and will therefore be blank and totalling
zero hours.

Adjusted Report with daily totals
The “all scans” report shown on the previous page may contain too
much detail for some uses, so an alternative is just to show the daily
totals without the actual scans.  In this particular example, there’s not a
lot of difference between the two reports, because this particular
employee only had one pair of scans per day.

However, if the employee had clocked in and out for lunch, or had more
than one work period in a day, the “all scans” report would have been
one line for each work period for each day.
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Adjusted Report with Weekly Totals
FirstStep can generate an even more concise report, showing one week
per line, as shown below.

Across the top of this report, there’s a header line with the names of
each of the columns down the report.  Then, for each employee, there’s
a line containing the name, ID and Workzone of each employee listed.
The first column shows the date of the first day worked during the
week, and the following figures are in columns under the days of the
week that the hours were worked.  Those hours are then distributed into
the pay category columns, and totals for the week are given at the end
of each line.  At the bottom, totals for the pay category columns are
shown.

Unadjusted Reports
FirstStep can also produce unadjusted versions of the All Scans, Daily
Totals and Weekly Totals reports.  These are identical in layout to the
Adjusted reports, but the times listed are the raw, unadjusted times -–
that is, the actual times the employee clocked in and out, with no
rounding and no editing.

Employee List
This report presents a list of all employees currently in the database.
The list can be sorted in last name, first name, or employee ID order.
Shown below is a segment of an Employee List Report.

In this example, the list is sorted by last name.  Each line contains the
name of the employee, their Employee and Export ID’s, workzone, and
the date they commenced work (or were entered into the database), and
the date their employment was terminated (if it has been).
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Export Report
FirstStep is able to export a text file for importing into other programs,
using the ASP Standard Format, which creates a text file like this:

"ADAMS","Glenn","773",75.00
"ALLAN","Rachael","777",67.50
"ALLSOP","Tony","1611",75.75
"ANDERSON","Debbie","2531",76.00

This file contains a single record for each employee, with each record
containing the surname, first name, employee ID number, and total
number of hours worked for the selected period.
Optionally, header lines can be included at the beginning of the text
file, as follows:

"11:35:17 AM","Monday, 6 November 2000","Test Company"
"Surname","First_Name","Employee ID","Normal"

The first optional header line contains the time, date and company
name, while the second optional header line contains the names of the
fields in the following data.  Either or both of these lines can be added
using the relevant checkbox on the Export tab.
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Screen Layouts and Menus
The following section of the manual is reference material, describing
the layout and function of each of FirstStep's screens.

The Edit Scans Screen
The Edit Scans screen is where you’ll do most of your work.  You
select a starting date, then an employee, and you get a spreadsheet-like
view of the Display Period, with all the clock in and clock out pairs of
times for the employee for that period.

You can select an employee by pressing the  button at the right of the
employee’s name, then selecting an employee from the drop-down list,
or you can move back and forwards through your employees by using
the  buttons to the left of the employee’s name.
The unadjusted times for the currently selected day (that’s the day with
the  to the left of it) are displayed near the bottom of the screen – in
the example above, the unadjusted times for June 1st are displayed.
Unless you’ve already edited or changed the times, the differences
between the adjusted and unadjusted times are due to the Rounding
Options you’ve set for the whole program, or for this employee.  In the
example above, the unadjusted In time for Friday June 1st of 08:49 has
been Rounded Up to the next 15 minute interval to become 09:00, and
the unadjusted Out time of 17:41 has been Rounded Down to the
previous 15 minute interval to become 17:30.  See the Options screen
for more information on rounding.
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The Employees Screen
When you open the Employees screen, you are presented with a
spreadsheet-like view of your employees, listed in the order they were
entered into the database.

You can change the order of the display by clicking on one of the
headings, which will sort the list by that column.  To reverse the sort
order, just click somewhere in the same column, then click on the
heading again.
The currently selected employee is indicated by the  on the left of the
list.  To select a different employee, just click once anywhere on the
line containing that employee.  If you have more employees than fit
onto the screen, use the scroll bar on the right, or the  and 
buttons at the bottom of the screen, to move backwards and forwards
through the list of employees to bring the desired employee into view,
then click on the line containing the employee.
To delete an existing employee, select the employee, right-click to
bring up a menu, then select Delete.  A confirmation message will pop
up, and if you answer Yes, the employee record will be permanently
removed from the data file.
To edit an employee, select the employee, then right-click to bring up a
menu, then select Edit to bring up the Edit Employees screen as shown
on the next page.
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To add a new employee, right click to bring up a menu, then select
Add New to
bring up the
same screen,
only with all
the fields
blank so that
you can
enter the
details for
the new
employee.
Note that the
Employee
ID must be
unique – the
same ID
cannot be given to more than one employee.
The Rounding, Meal Break, Overtime, Midnight and Auto
Highlight tabs are the same as, but override, those on the Options
screen.  This allows you to have, for example, overall settings that
affect most employees, and then have different settings for particular
employees.

The Data Collection Screen
Pressing the Download button on the main screen brings up the Data
Collection screen.
The Last Poll section shows the date and time of the last successful
data collection
operation, while the
Next Poll is the time
and date of the next
scheduled automatic
poll as defined in the Download Setup screen.  If there are no
scheduled polls, this field will display Manual Poll.
The Polling Activity field shows any currently occurring activity, such
as which unit is being polled, and indicating when the downloaded data
is being processed.
While collected data is being processed, a progress bar is displayed in
the grey section of the screen.
To start a data collection immediately, press the Manual Poll button at
the bottom right corner of the screen.  As a convenience, there’s also a
button that takes you to the Download Setup screen.
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The Reports Screen
The Reports screen consists of four sections - Dates, Options,
Employees, and Export.
When you enter the Reports screen by pressing the Reports icon, the
first screen you’re shown is the Dates tab, where you can enter the
range of dates that will appear on the report, and set how you want the
reports sorted.
The From: date is
initially set to the same
as the Start Date on the
Edit Scans screen, and
the To: date is initially
set to From: date plus
the number of days set
in Display Period on
the Options screen.
This is done because
you’re most likely to
want to print out data
for the same period that you’ve edited, but you can change these dates
to any period you wish.
To create a report, select the report period and the various options
described above, then press the Print or Preview buttons.  The Print
button sends the report directly to the selected printer, while the
Preview button opens a display window so that you can view the report
on the screen.  There’s also a print button on this display window, so
that you can commit the report to paper if you so desire.

Options tabOptions tabOptions tabOptions tab
The Options tab lets you select the type of report you want to generate,
and the level of detail you want in the report.  You can generate an
Employees List, an Unadjusted Scans or Adjusted Scans report, or
an Export file.  With the Unadjusted and Adjusted scans reports, you
can also choose to list all scans, or only the daily or weekly totals.

Select tabSelect tabSelect tabSelect tab
On the Select tab, you can select whether a report contains all
employees, only selected employees, or only selected workzones.
Selections are made with checkboxes.
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The File Menu
FirstStep’s File menu provides access to the
following database maintenance functions,
as well as (in some circumstances) allowing
you to create or open a new database.
If the FirstStep.mdb database file exists
when FirstStep is run, that database is
opened automatically.  If there is no existing FirstStep.mdb database
file, a message will be displayed asking whether you want to create a
new database file.  You can answer yes or no, with obvious results – the
new file either will or will not be created.
If you answer no, FirstStep will start without a database, and you will
not be able to do anything until you create a new database or open an
existing one.  Selecting New Database will create a new database, and
selecting Open Database will open a FirstStep.mdb database file if it
exists.

Repair Database
Selecting Repair Database from the File menu instructs FirstStep to
check the database, and re-establish indexes and pointers to the data in
the database.  The Repair Database function would normally only be
used in circumstances such as the computer being turned off while you
were using the program, which may result in database corruption.  This
function will endeavour to recover as much data as possible, and will
warn you if any of the data could not be recovered.

Compact Database
Selecting Compact Database from the File menu checks the current
database, and reclaims any available space in the database to reduce its
size.  You should try to compact your database regularly (once a month
is ideal) to allow FirstStep to run most efficiently.

Archive Database
After you’ve been using FirstStep for some time, you may find that it’s
not as quick as it used to be at some functions.  This is because the
database grows with the new data added every day, and larger files take
longer to process.
When FirstStep archives a database, all the basic information in the
database, such as the setup information and the current employees, are
carried forward, while the same information, plus past employees, and
all data from the start of the current database up to and including the
archive date, are left behind in the archived file.
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Note that the archived database is a read only file, and accordingly no
changes can be made to its contents once it has been archived.
The FirstStep database may be archived at any time, up to a date at least
two days prior to the present date, but we recommend that the archive
date corresponds with the end of a pay period.
To archive your database, select Archive Database from the File
menu.  The Archive Database box will tell you the date up to which the
archive will include, and allow you to change the date with the by now
familiar pop-up calendar.  The box will also suggest an Archive
Filename, which includes the date in reverse.  Although you can change
this name, it is recommended that you use it to ensure consistency.
Once the old data is archived and saved under the specified filename,
you will not be able to open it with FirstStep, because FirstStep is
designed to allow only a single database called FirstStep.mdb.
However, if you manually rename the FirstStep.mdb file to something
else, then manually rename the archived data file to FirstStep.mdb, you
can then open it, remembering that it will still be read-only.  You must
remember to rename the files again when you’re done.
Other members of ASP’s Time and Attendance family of products do
not have this restriction.

Manual Poll
Selecting Manual Poll from the File menu performs exactly the same
function as pressing the Manual Poll button on the Download screen.

Import
To save time and effort, FirstStep allows you import a list of employees
rather than type them in manually.  You can import all or any of the
employee information on the General tab of the Add Employee screen,
but the minimum information needed by FirstStep is the employee’s
first and last name and their employee number.
If you don’t import a Commencement Date, it will be set to the current
date.  If you don’t import an Export ID, it will be set to the Employee
ID.  If you don’t import a Workzone, it will be set to Default.
FirstStep’s import facilities are quite comprehensive, but also rather
technical and because of this, importing data may be confusing to some
users.  See Importing Employee Details from a Text File on page 37
for more details.  If you need help importing an employee list, please
contact ASP.
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Copy Employee File To Floppy Disk
ClickClock needs to always have access to an up to date list of
employees, so that the names can be displayed on the screen for your
employees to select.
If ClickClock is installed on a computer that is not connected to the
computer running FirstStep, you can use this function to copy
FirstStep's employee list to a floppy disk, and then take the floppy disk
to the computer running ClickClock and select Import Employees File
from the File menu there.

The Setup Menu
The Setup Menu gives quick access to all of
FirstStep’s configuration screens.

Printer Setup
In many workplaces, computer users can use more
than one printer, and this menu item allows you to select and configure
the printer that FirstStep will use for reports.

Employees
Selecting Employees from the Setup menu is the same as pressing the
Employees icon on the main screen – it takes you to the Employees
screen, as described on page 25.

Download
Selecting Download from the Setup menu is the same as pressing the
Data Collection icon on the main screen – it takes you to the Data
Collection screen, as described on page 26.

Pay Categories
This menu item allows Pay Category Names to be defined, and these
defined names can then be selected anywhere in FirstStep that uses Pay
Category Names.
FirstStep has four pay categories, which are shown on reports as
Normal, Overtime1 (or OT1), Overtime2 (or OT2) and Overtime3
(or OT3).
Normal hours are an employee’s basic working hours for a day.  The
overtime categories are set to start after a specified number of hours
have been worked for a day.
Although FirstStep has only four different categories, and the four
categories are listed and totalled in reports under the names given
above, the categories can be assigned different names for Export
Reports, both on a global and individual basis.
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Options
The Options screen is where all the major settings for FirstStep are
controlled from.  The Options screen contains six sections, which are
described below.

Rounding tabRounding tabRounding tabRounding tab
If employees clocked in
and clocked out at their
exact starting and
finishing times, there’d
be no need to adjust
their scan times.  In the
real world, though, most
employees will usually
clock in a little early,
and clock out a little
late.  Sometimes,
someone might get to work a little late, or go home a minute or two
before knock off time.  By the end of the pay period, instead of their
hours adding up to exactly the right number, the actual totals based on
their scan times will most likely be all over the place.
FirstStep’s Rounding Option is designed to save you time and
headaches by automatically adjusting clock in and clock out times
based on rules that you set, both as overall rules, and as separate rules
for individual employees if needed.
FirstStep can be set to automatically round the clock in times and the
clock out times to rules that you set.  You can decide to Round Up,
Round Down, or Round to the Nearest interval of 5, 6, 10, 15, 30 and
60 minutes.
Note that all clock in times are adjusted by one rule, and all clock out
times are adjusted by another rule.  And, if your employees clock in and
out for their meal breaks, those times will also be adjusted using the
same rules.
Using these rules, you might decide to automatically round all clock in
times up to the next 15 minutes.  That way, if an employee clocked in
between (for example) 08:46 and 09:00, their clock in time would
automatically be adjusted to 09:00.  If they clocked in late between
09:01 and 09:15, their clock in time would be rounded up to 09:15.
Similarly, you might decide to round down their clock off times to the
previous 15 minutes.  That way, if they clocked off between (for
example) 17:30 and 17:44, their clock out time would automatically be
adjusted to 17:30.  If they clocked out early between 17:15 and 17:29,
their clock out time would be rounded back to 17:15.
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The following table shows the results of the Round Up, Round Down
and Round to Nearest settings for various scan times:

Actual scan
time

Round up to
next 15 mins

Round down
to previous

15 mins

Round to
nearest 15

mins
08:29 08:30 08:15 08:30

08:30 08:30 08:30 08:30

08:31 08:45 08:30 08:30

08:40 08:45 08:30 08:45

08:44 08:45 08:30 08:45

08:45 08:45 08:45 08:45

08:46 09:00 08:45 08:45

08:50 09:00 08:45 08:45

08:55 09:00 08:45 09:00

08:59 09:00 08:45 09:00

Note that the Rounding setting affects all employees, but you can create
different overriding settings for individual employees from the Edit
Employee screen.

Meal Break tabMeal Break tabMeal Break tabMeal Break tab
Some workplaces pay their employees for their meal breaks, which
means that the meal break time doesn’t have to be subtracted from the
working hours for the day.  In these cases, FirstStep doesn’t need to do
anything special for or about meal breaks.
Other workplaces require their employees to clock out for their meal
breaks, and then clock in when they’re finished.  Again, FirstStep
doesn’t need to do anything special here – the meal break time will be
removed because they’ve clock out then back in again.
FirstStep can be configured to subtract a fixed amount of time for a
meal break when an employee has worked more than a configurable
number of hours for the day.  For example, FirstStep it could be set to
subtract an hour once an employee had worked more than 5 hours.
This setting affects all employees equally, however it can be over-
ridden for individual employees from the Edit Employee screen.

Overtime tabOvertime tabOvertime tabOvertime tab
FirstStep provides for three overtime categories, which start after a
certain number of hours have been worked.  For example, the first
category could be set to start after 7:30 hours (ie 7.5 hrs) had been
worked, and the second category could be set to start after 9:00 hours
had been worked.  You don’t need to use all three overtime categories –
in fact, you don’t need to use this facility at all.



ASP TimeSheet FirstStep 33

Note that the times entered here are hours and minutes worked, not the
time of day that overtime starts.
By unchecking the Same settings for every day option, you can use
different overtime settings for different days of the week.  Otherwise,
the same settings are used for every day.
The overtime settings affect all employees equally, however they can be
over-ridden for individual employees on the Edit Employee screen.

Midnight tabMidnight tabMidnight tabMidnight tab
FirstStep always works with single days – a work period is not allowed
to continue over midnight.
If an employee does work over midnight, FirstStep is able to handle the
situation by “pretending” that the employee finished work at the end of
one day (ie at 24:00), then started work again immediately at the start of
the next day (ie at 00:00).
FirstStep can be set to automatically add a 24:00 scan to the end of a
day and a 00:00 scan to the start of the next day, when the final scan for
the day is within the specified number of hours before midnight.  You
should consider the use of this option carefully – FirstStep applies the
rule, and if the scans for the day meet the rule, the extra 24:00 and
00:00 scans are added, which may not always be what you want.  When
you’re editing times, it’s always possible to manually add the 24:00 and
00:00 times from the right click menu, and you can also easily delete
any 24:00 and 00:00 times that have been automatically added.
This setting affects all employees equally, however it can be over-
ridden for individual employees from the Edit Employee screen.

Display Period tabDisplay Period tabDisplay Period tabDisplay Period tab
This is where you set the number of days that are displayed on the Edit
Employees screen, and the default number of days for reports.

Auto Highlight tabAuto Highlight tabAuto Highlight tabAuto Highlight tab
FirstStep can be set to automatically highlight days where the hours
total for that day is more or less than figures you specify.  For example,
if your employees normally work seven and a half hours a day, you
could set this to highlight days where more than 7:30 hours or less than
7:30 hours had been worked.
Even if your employees don’t work such regular hours, there might still
be some benefit in highlighting days where more or less hours than you
are expecting have been worked.  For instance, perhaps everyone is
supposed to work more than three hours and less than twelve hours.
FirstStep will always highlight days where there are an odd number of
scans in that day to bring those days to your attention.
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This setting affects all employees equally, however it can be over-
ridden for individual employees from the Edit Employee screen.

Password
FirstStep allows you to set up an access password so that unauthorised
people can’t get into FirstStep and alter important details.  You don’t
have to set a password - it’s entirely up to you to determine whether the
added security is important.
Selecting Password from the Setup menu will bring up the Change
Password window.  Since this is the first time you’ve set a password,
you can ignore the Old Password text entry box - there won’t be an old
password.  Click in the New Password box, then type your password,
which can be up to 30 characters long.  Then, click in the Verify box
and type your password again.  If the two passwords are the same, your
new password will be set.  If they’re not, a warning message is
displayed, and you’ll have to enter your new password again.

Company Name
Setting up FirstStep with the name of your company is just as easy -
just click on the Setup menu, then select Company Name to bring up a
window where you can type up to 25 characters.  The Company name
appears on the top of the FirstStep screen, and on all reports.

The Edit Menu
The Edit menu contains two items – Employees and Scans.  Selecting
one of these menu items takes you directly to the Employees or Edit
Scans screens, just like pressing the icons on the left of the screen.

The Reports Menu
The Reports menu provides access to all
reports that FirstStep can generate, exactly
as is available by pressing the Report icon
on the left of the screen.  However, when
you use the Report Icon, you have to select
the type of report, whereas when you select
a report from the Reports Menu, the chosen
type of report will already be selected.
The exception is the Evacuation report, which appears only on this
menu.  When selected, FirstStep immediately collects clocking data,
then prints a report of all employees who have clocked in for the day,
but have not clocked out.  Subject to situations such as staff having
clocked out but remain in the building, or who are in the building but
have not clocked in, this report shows all staff on the premises.
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The Help Menu
The Help menu provides you with access to a
number of resources to help you use FirstStep.
The first item on this menu is Contents, which
brings up a standard Windows help file.
Selecting Web Page from the next section of
this menu will take you to the Time and
Attendance section of ASP’s Internet web site (if you have a web
browser and Internet access).  This section of our web site will be
gradually expanded to provide access to the latest version of programs,
downloadable manuals, product notes, and answers to frequently asked
questions.
You can Send Email to Tech Support, provided you have an email
program correctly installed on your system.  This is an ideal way to
obtain answers to your technical support queries.
If you select Ordering information, a text file containing information
on how to purchase FirstStep will be displayed.  Similarly, clicking on
License Agreement will display the licensing agreement for FirstStep.
Selecting About displays the FirstStep “splash screen”, which gives
you the program version number, copyright information, a link to
ASP’s web site, and a System Information button that can be used to
display technical information about your computer.  To remove the
splash screen, just click anywhere on it (other than on the web site
address or the System Info button).
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Data Collection and Downloading
Before you can start collecting clock-in and clock-out times for your
employees, you need to configure the Data Collection section of
FirstStep.  You can do this by clicking on the Setup menu, then
selecting Data Collection from the menu, to bring up the screen shown
below.
The usual way of
collecting clock in
and clock out data
for FirstStep is using
the ASP ClickClock
program, which
creates a text file
that FirstStep can
import.  Or, you can
use ASP’s ZipNet
Terminals, either
wired-in or using the Direct DataTag Download facility, or any other
device or program that outputs a text file that FirstStep can import.
If you wish, you can give each scanner or data collection point a
Scanner Name, as we’ve done in the example screen above.  This
facility is more useful if you have ZipNet Terminals.
The Scanner Type can be set to ASP ClickClock, ZipNet Terminal,
Text File, or Direct DataTag Download.  In the above example, it’s
set to ASP ClickClock, which then enables the Text Input File section
of the screen, and disables the Address section.  In this section, you can
set the location and filename of the text file that FirstStep is to collect
data from.  This text file can be located on the same computer that
FirstStep is running on, or it can be located on another computer on
your network.
FirstStep will delete this text file once it has successfully collected the
data, and if the file is not there when FirstStep tries to collect data from
it, it’s not a problem.  The required format of the text file is described in
Importing Scan Data from a Text File on page 40.
You can set up more than one scanner, and they don’t all have to be the
same type – you could have, for example, one scanner set to ASP
ClickClock, another to Direct DataTag Download, three ZipNet
Terminals and two text files, or any combination.
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Finally, you need to
set when or how
often FirstStep will
collect data, from the
Poll Options tab, as
shown on the right.
There are three ways
that data can be
collected –
Periodically, where
FirstStep collects the
data at preset intervals (for example, every two hours, or every fifteen
minutes), Scheduled, where FirstStep collects the data at preset times

(for example, at 09:15 and 14:30), and Manual, where
the data is collected only when the Manual Poll button
on the Data Collection screen is pressed.
To set FirstStep to periodically poll the scanners, ensure
that the Scheduled Poll box is not checked, and select
the desired frequency of polling from the drop down box,
as shown on the left.

To set times for scheduled polls, ensure that the
Scheduled Poll box is checked, then click on the Add
button to add a poll time.  You must enter poll times in
24 hour format.  If you need to remove a time that
appears in the scheduled poll list, select it by clicking on
it, then press the Remove button.
Once you’ve configured a scanner, press the Save button to store the
settings, then press the Close button to get back to the main program.

Importing Employee Details from a Text File
Entering employee names, ID numbers, and other details can be
tedious.  If you already have your employee details entered into another
computer program, and that program can create a text file containing
the details, you may be able to import the file into FirstStep.
To import employee details from a text file, select Import then
Employee Details on the File menu, to open the wizard.
The first thing that the wizard needs to know is where the text file is
located, and you can set this by pressing the Browse button.
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Next, the wizard needs to know how the fields in the text file are
delimited – the
options are a
comma, a tab
character, or a
custom delimiter
that you specify.
After you’ve
specified this, the
screen shown on
the right will
appear:
In the area at the
top left, under
the heading Field
Structure of
import data file,
the contents of
the first row (or
record) of the
import file are displayed.  As described below, this will either be the
details for the first employee, or a description of the fields in the import
file.  If it’s a list of the field names, make sure the First row contains
field names checkbox is ticked, otherwise the field names will be
imported as if they were employee details.
Under the heading Field Structure of Employees table, the names of
the fields within FirstStep are displayed.  What you have to do is match
up the fields in the import database with the fields in FirstStep.  You do
this by clicking on a field name on the left side of the screen, and
clicking on a field name on the right side of the screen, then clicking the
Add button.
Once you’ve done this for all the fields you want to import (you don’t
need to import all fields, see below), the
Related Fields section of the screen will
look like the screen fragment on the right.
If you notice that you’ve made a mistake in
the Related Fields list, you can remove the
problem line by clicking on it, then
pressing the Remove button.  You can then re-select the correct fields.
Once you’re happy with the connections you’ve established between
the import file and the FirstStep database, click the Next button.  On the
following screen, you can press the Finish button to import the text file.
Any errors will be displayed on the screen, and also written to a text file
called ConversionErrors.txt in the folder that FirstStep is installed in.
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At any time before pressing the Finish button, you can press the Back
button to go back a step, or the Cancel button to quit without importing
the text file.
After importing the data into the database, the Employees screen will
be displayed again.  If everything looks okay, you can begin using
FirstStep.  If there were errors during the import, or the data doesn’t
look right on the screen, you should delete the employees you added,
and then begin again and repeat each step carefully.
FirstStep saves the connections you establish between the import file
and the database, and offers to use it the next time you import employee
details.  If you ever import a file of the same format in the future, this
saves you the step of having to define the related fields again.  If the file
you are importing is not in the same format as the last file you
imported, you must not use the previously saved related fields
information.
A fragment of a suitable text file is shown below:

"EmployeeID","Last_name","First_Name","Workzone","CommenceDate"
"60","THURLEY","Colleen","A1",1/1/00
"70","COAD","Jenny","A1",1/1/00
"80","KEENAN","Joan","A2",1/1/00
"90","YOUNG","Judith","A4",1/1/00
"130","WHITING","Anne","A1",1/1/00

The following requirements and limitations apply to the import file:
• Each line of the text file must contain a single record, with each

record separated into fields by a comma, tab or user-defined
character.

• Text fields within each record must be surrounded by quotation
marks.

• The first line of the text file can contain either the names of the
fields in the following lines, or employee details.  If the first line
of text contains field names, make sure that you check the First
row contains field names checkbox.

• Dates must be in the form dd/mm/yy, with the day and month as
one or two digits.  The year must be two digits only – four digit
years are not allowed.

• The text file must contain at least an Employee ID, a
First Name, and a Last Name.  If the file doesn’t contain an
Export ID, it will be set to be the same as the Employee ID.  If
the file doesn’t contain a Workzone, the workzone will be set to
Default.  If the file doesn’t contain a Commencement Date, the
commencement date will be set to the current date.

• Finally, remember that FirstStep has a limit of 16 employees –
once you reach that limit, any further records in the text file will
not be imported.
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If you need help with importing an employee list into FirstStep, please
contact ASP or your dealer.

Importing Scan Data from a Text File
Although FirstStep is designed to be used primarily with ASP’s
ClickClock program, or with ASP’s ZipNet Terminals or Direct
DataTag Download setup, any other device or program that can create a
text file in the correct format can also be used.
When FirstStep is configured to collect data from a Text File, the text
file must contain one or more lines of text in the following format:

"12345","18:14","19-10-2000"

Each line of the file must contain three fields, with each field contained
within quotation marks, and separated from the next field with a
comma.
The first field is the employee barcode or identification number, and
must match FirstStep’s Employee ID.  The remaining two fields are the
time and date that the scan was made.  The time must be in 24 hour
format, with the hours and minutes separated by a colon.  The date must
consist of the day, month and four digit year, separated with dashes.
The employee number field can optionally end with a > or < character
to signal the intended direction of the scan, as shown below, where the
first line is a clock in and the second line is a clock out.

"12345>","09:00","19-10-2000"
"12345<","17:30","19-10-2000"

TimeSheet FirstStep accepts, but ignores, this direction indication.
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Common Questions and Answers
What if I have more than 16 employees?

If you have more than 16 employees, you should upgrade to TimeSheet
Express, or one of ASP’s other Time and Attendance systems.

How can I re-use an employee ID number?
FirstStep doesn’t allow more than one employee to have the same
employee ID number.  If you need to re-use a previously used employee
ID number, you have to change the employee ID number for the
previous staff member before you can re-use that ID number for a new
employee.
Click on the Employees button on the main screen, select the previous
employee, right click, select Edit from the menu that pops up. and then
change the Employee ID.  We suggest you add something like the date
of termination to the previous employee’s ID number, so that you avoid
complications if an ID number has been re-issued multiple times.  For
example, an existing ID number of 12345 might become 123450005 to
signify that the employee left in May 2000.
Once you’ve changed the ID for the employee who previous held that
ID, you can add the new employee and re-use the employee ID for
them.

What happens if I adjust times in the future?
FirstStep keeps two sets of times – the raw unadjusted scans, which
show the actual time of each scan, and the adjusted times, which are
created by the application of the Rounding rules, or by manual editing
from the Edit Scans screen.
Once adjusted times are created automatically, or are entered manually,
no further automatic adjustments can be made.  What this means is if
you manually enter times for any day that you haven’t yet collected
scans, when the collected scan data is eventually processed, the
rounding options will not be automatically applied, because they would
then override the manual adjustments you’d already made.
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Glossary
This section contains definitions for terms used in the program and in
this manual.

Activation Key An Activation Key is used to unlock the evaluation
versions of FirstStep and ASP ClickClock and turn
it into a fully functional program, without the 14
day limit.  To generate your Activation Key, we
need your Hardware Fingerprint, and the name
you want the program registered under.

Adjusted Report This report shows the adjusted clock in, clock out
and hours worked times.  The list of hours worked
on this report is what you need to transfer to your
payroll system.

Adjusted Times Unadjusted times become Adjusted times after they
have been edited or changed manually from the
Edit Scans screen, or when they are automatically
change via Rounding options.

Barcoded Cards Credit card sized plastic Barcoded Cards are the
simplest, least expensive, and most common way of
identifying employees.
Barcoded cards can be printed with text, logos,
photographs, the employee's name and signature,
and can sometimes be used for other purposes (ie
library lending cards, membership or identity cards,
etc).

Clock In Time The Clock-in Time is the time that an employee
scan in for a period of work.
Employees typically clock-in at the start of a
working day, and then clock-out at the end of the
working day.  In some workplaces, employees may
also clock-out at the start of their meal break, then
clock-in again when their meal break is over.

Clock Out Time The Clock-out Time is the time that an employee
scans out after a period of work.

Commencement
Date

An employee's Commencement Date is the date
that an employee started work for the company, or
the date when the employee was entered into
FirstStep.

Company Name The Company Name is used in the title bar of the
main screen, and at the top of all printed and on-
screen reports.  It is set by selecting Company
Name from the Setup menu.
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Currently
Selected Day

The Currently Selected Day is the day with the 
to the left of it on the Edit Scans screen.  The
unadjusted times for this day are shown at the
bottom of the screen.

Date Entry
Shortcut Keys

The keyboard Pg Up and Pg Dn keys move back or
forwards one month, the Up arrow and Down
arrow keys move back or forward one week, and
the Left arrow and Right arrow keys move back
or forward one day.
The Home key resets the date to the first day of the
month and the End key sets the date to the last day
of the month.
The Esc key cancels date selection, and the Enter
key selects the highlighted day and exits back to the
Reports Selection window.

Display Period The Display Period is the number of days that are
displayed on the Employees screen, and the default
number of days for Reports.

Download This the term used to describe the collection of scan
data from ASP ClickClock, ZipNet Terminal(s), or
text files.

Employee ID This is a unique but otherwise arbitrary number
assigned to each employee and used by FirstStep to
identify the employee.  If you're using cards or
IDTags, it is the number encoded on the barcode
card or IDTag.

Export ID The text entered into the Export Identifier field is
used on the Adjusted Attendance report to label
hours worked within the defined category. Export
Identifiers are also used with the export facility.

Global Setting A global setting is one that affects all employees.
Global settings can be over-ridden for individual
employees.

Hardware
Fingerprint

A Hardware Fingerprint code is a code that is
unique to a particular computer.  The Hardware
Fingerprint is used, together with the name the
program is registered to, to generate an Activation
Key to register your copy of FirstStep and
ClickClock.

Help Button Pressing this button brings up the online help
window.
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Meal Break A Meal Break is just what it sounds like - when
your employees have their lunch (or other meal).
FirstStep can be set to automatically deduct a meal
break after a certain number of hours have been
worked in a day.

Normal Hours Normal hours are an employee's basic working
hours for a day.  The overtime categories can be set
to start after a specified number of hours have been
worked for a day.

Overtime The term Overtime, as used by the FirstStep
program, refers to hours worked after a specified
number of normal hours have been worked in a
shift.  The rates these hours are payed at is entirely
up to you and your payroll program.
FirstStep has three overtime categories, which are
called Overtime1 (or OT1), Overtime2 (or OT2)
and Overtime3 (or OT3) in reports.  Pay Category
Names can be used to identify these categories in
export reports.
Overtime categories are set to begin after a
specified number of hours have been worked.  For
example, category Overtime1 might be set to start
after 8 hours have been worked in a day, and
category Overtime2 might be set to start after 9.5
hours have been worked.

Password The Password is used to control who has access to
the FirstStep database.

Pay Category
Names

Pay Category Names are labels that can be assigned
to the Normal Hours and Overtime Hours
definitions in Shift Profiles.

Payroll Export
ID

The Payroll Export ID is the number used in your
payroll program to identify an employee.  If a
Payroll Export ID is set, it will be used in the
export file, otherwise the Employee ID will be
used.
The Payroll Export ID is used where you cannot
change the Employee ID numbers in your payroll
program to suit the card or IDTag numbers used by
FirstStep.

Payroll System This term refers to your existing manual or
computerised payroll system.
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Pop Up
Calendar

The currently selected date is highlighted by a grey
oval.  If the displayed month is the current month,
today's date will be circled in red.
To move backwards or forwards by one month,
click on the arrows at either side of the month and
year, or press the keyboard Pg Up and Pg Dn keys.
To select a different month from a list, click on the
month name.  To select a different year, click on
the year to display a pair of buttons to step through
the years.
To move backwards or forwards by one week,
press the keyboard Up arrow and Down arrow
keys.  To select the first or last day of the month,
press the keyboard Home or End keys.
To select a date using the mouse, simply click on
the desired day.  To select a date using the
keyboard, use the Left arrow and Right arrow
keys to locate the day, then press Enter to select
the highlighted day.
You can press the Esc key to cancel date selection
and retain the current date.

Read Only File A Read Only File is one that has been created in
such a way that no new data can be added to it, and
the data already in it cannot be changed.

Start Date The Start Date is the first date listed on the screen
or on a report.  In most cases, this will be the first
day of your pay period.

Termination
Date

An Employee's Termination Date is the date on
which the employee ceased to work for the
company.

Total Hours
Worked

The Total Hours Worked are the adjusted hours
worked by an employee in a shift period.

Unadjusted
Report

This report shows the actual clock-in and clock-out
times for each employee, as they were scanned,
with no adjustments made.

Unadjusted
Times

Unadjusted times are the actual times that people
clock-in and clock-out.



ASP TimeSheet FirstStep 46

UNC Filename UNC is short for Universal Naming Convention, or
Uniform Naming Convention, and is a way of
specifying the location of a file on a local-area
network (LAN).  A UNC filename uses the
following format:
\\server-name\shared-resource-pathname
So, for example, to access the file test.txt in the
directory examples on the C: drive of the server
silo, you would use the UNC filename
\\silo\c\examples\test.txt

Working Hours Working Hours is the term used by FirstStep to
refer to the hours worked by an employee during a
shift.

Workzone A Workzone is simply a convenient way to group
employees.

ZipNet Terminal A Time and Attendance data collection terminal,
which displays the time, and accepts and stores data
from IDTags and barcoded cards.
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Copyright, License and Limited Warranty
TimeSheet FirstStep and ASP ClickClock are a proprietary products of
ASP Microcomputers and are protected by copyright laws.  Once
installed on a computer, a system-specific activation code is required
from ASP to enable unlimited use of the programs on that computer.
Copies of TimeSheet FirstStep and ASP ClickClock in their original
inactivated limited trial versions may be supplied to others for
evaluation on the basis that they will similarly contact ASP to purchase
a licence and obtain an activation code should they wish to have
unlimited use of the programs.  Subject to this authorisation, copyright
laws prohibit making additional copies of the software for any other
person.
The TimeSheet FirstStep package contains two application programs.
ASP Microcomputers grants the purchaser of this package a license to
use one copy of each program on a single-user computer.  The
programs may be installed on the same or different computers.  The
purchaser is not authorised to sub-license, rent or lease the software.
You may permanently transfer your license to use the software by
passing the original disk and manual to another person and
simultaneously destroying all copies of the software and documentation
in your possession.  Such a transfer terminates your license to use the
software.  The new possessor of the software accepts a license to use
the software on the basis expressed here on first use of the software.
ASP Microcomputers undertakes that the software will perform
substantially as described herein, and will correct “bugs” notified by
licensed users within a reasonable time.  Should such “bugs” not be
correctable, the only remedy available will be return of the software for
refund.  This warranty is in lieu of other warranties express or implied
including but not limited to the implied warranties of merchantability
and fitness for purpose.  In no event will ASP Microcomputers be liable
for damages including loss of profits or other consequential damages
arising out of use or inability to use the software.
This limited warranty gives specific legal rights.  Some states give other
rights and/or do not allow excluding or limiting implied warranties or
limiting liability for consequential damages.  Accordingly, the above
limitations/exclusions may not apply to you.  If any provision of this
agreement shall be void unlawful or unenforceable then that provision
shall be severable without affecting the validity of remaining
provisions.  This agreement is governed by the law of Victoria,
Australia.
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